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Welcome to the CADAC Sound Automation Manager (SAM). This manual will 
describe the various procedures and actions needed to fully utilize the Sound 
Automation Manager and achieve flawless performance. Being the result of 20 years 
research, development and investment, it goes without saying that CADAC’s software 
embodies a highly flexible and capable package, reflecting the continuously 
increasing requirements of Sound Engineers all over the world. The Sound 
Automation Manager’s boundaries are virtually limitless - applications range from that 
of a completely stand-alone system to the vast support of multiple frame consoles with 
equal ease.
 
The concept of SAM ensures that the highest levels of control can be achieved - 
whether operating complex multiple frame consoles or providing a complete and 
accurate picture as digital audio technology progresses towards increasingly smaller 
work surfaces. Furthermore, the Sound Automation Manager and its setup program 
have been extensively rewritten to support Unicode languages, allowing you to enter 
and store the cue text in your own language. Future versions of the Sound Automation 
Manager will be available in native languages. Contact your local CADAC 
representative for more information.

The CADAC product line is being continuously developed. Consequently, it may 
follow that this manual does not include details of features that recently have been 
added. If so, you may find it useful to check SAM’s on-line HELP-system, or go to the 
CADAC web site at www.cadac-sound.com. Another option may be to check the 
supplied CD-ROM for a later version of the manual. Also, make sure that you always 
check the installation disk for a ReadMe file.

Support is of course also available directly from CADAC. You are very welcome to e-
mail your enquiries to us on info@cadac-sound.com. If you know the name of the 
person you need to talk to, then just replace ‘info’ with the first name of that person. 
Alternatively, you may specify the department, for example “Sales”.

CADAC can also be contacted via mail or telephone/fax:

CADAC Electronics plc
One New Street
Luton
Bedfordshire
LU1 5DX
United Kingdom
Phone: +44 (0)1582 404202
Fax: +44 (0)1582 412799

At CADAC, customer focus is always at the forefront and we will be more than happy 
to discuss your suggestions as to how our products could be improved. Therefore, 
please feel free to submit your ideas, suggestions or requirements, and we promise 
to give you our full attention.
5-2 Sound Automation Manager
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414 &RPSXWHU#UHTXLUHPHQWV

To run the Sound Automation Manager requires a computer with the minimum per-
formance and peripherals as listed below:

IBM PC compatible computer
Windows ® ‘98 (second edition), 2000, XP or XP Pro
Graphics card 1024 x 768 pixels, High Colour 16-bit or better

Ethernet interface 10Mbit/sec with 10base2 connector (BNC)1 
128 MB RAM
20 MB free hard disk space

PS/2 keyboard (older 5-pin DIN keyboard can be used with adapter)2

PS/2 mouse or pointing device (9-pin’D’-serial devices cannot be used)3

415 ,QVWDOOLQJ#IURP#&'0520

The Sound Automation Manager software is normally supplied on a CD-ROM. To 
install SAM, place the CD in the CD-ROM drive on your computer. Depending on the 
supplied version of SAM, the installation process may or may not start automatically. 
If it does not, follow these steps to manually install the software:

■■■■ In the Windows Start menu, click on Run…. A dialog box opens, see fig 1-1. In 
the box Open, type D:\setup.exe and click OK. If your CD-drive has a different letter 
assigned to it, substitute this letter for D.

The installation process starts and you will be guided through each step. Each set-
ting has a default option. Accept the default option unless a CADAC engineer or 
other qualified person has instructed you otherwise.

1. The Seance box is supplied with 2 10base2 cables, 2 T-pieces and 4 terminators.
2. The Seance box interface can switch 1 keyboard, 1 mouse and 1 monitor between 2 com-

puters. The Seance box is fitted with PS2 connectors.
3. See 2.

FIG 1-1.  The Run program dialog box
5-2       Sound Automation Manager
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If your copy of the Sound Automation Manager has been supplied on diskettes, 
insert the diskette labelled 1, in the diskette drive on your computer.

In the Windows Start-menu, click on Run…. A dialog box opens, see fig 1-1.

In the box Open, type A:\setup.exe and click OK. If your diskette drive has a different 
letter assigned to it, substitute this letter for A.

The installation process starts and you will be guided through each step. Default 
options are offered for each setting. Accept the default option, unless a CADAC engi-
neer or other qualified person has instructed you otherwise.

417 &RPPXQLFDWLQJ#ZLWK#WKH#FRQVROH

The Sound Automation Manager communicates with the console either via the 
Seance interface or uses USB technology. 

In the case of a Seance interface, Ethernet hardware and TCP/IP software for com-
munications is used. Current consoles use the proprietary CADAC Fast Copper 
Comms system (or the earlier fibre optic system). To use the SAM software, CADAC 
has designed an interface unit called Séance. This interface links the console com-
munication system with the new world of Ethernet. See the Seance manual, section 
2,  for further information.

Newer products, for instance the R-Type console, have been equipped with USB 
connectors, which eliminates the need for a Seance unit. Setting up a USB commu-
nications system is easier than TCP/IP - the only action required is to tick a box in the 
dialog box. The USB driver and interface system can handle all of our USB-based 
products, meaning once the driver is installed it is globally available.

Where SAM is set up to use USB communications, it also runs a smaller helper pro-
gram called SamUSB, which is accessible from the system tray at the bottom right of 
the screen. A green tick on the SamUSB icon indicates that the program has found 
one or more USB products to communicate with. Available units can be listed by 
right-clicking the icon and select ‘Status’ from the pop-up menu. You then enter the 
unit ID in the Network Settings dialog to let SAM know which unit to communicate 
with.

418 3RZHULQJ0XS#VHTXHQFH#RI#3&V

Always use the following procedure:

■■■■ Power-up console
■■■■ Select PC1 on the CCM and power up the first computer. Wait until the PC1 
computer has completed its boot-up routine, then...
■■■■ Switch to PC2 on the CCM and power-up the second computer and wait until it 
has completed its boot-up routine.
■■■■ Power-up the Seance-box.

Once both computers have booted correctly, they should allow the keyboard and 
monitor to be switched back and forth without problems.

If the overall cable length for the keyboard and monitor are very long (greater than 
5m), it may be necessary to use a keyboard and a monitor booster unit to retain key-
board reliability and clean monitor display.
tomation Manager Revision SAM2005-2



Installing the CADAC Sound Automation Manager 1-3

Revision SAM200
419 )XUWKHU#LQVWUXFWLRQV#DQG#+HOS

After you have installed the Sound Automation Manager, there will be a Readme  file 
in the SAM menu entries in the Windows® Start menu. Always read this file to check 
for changes and new features in the program if you have installed a new version.
When running the Sound Automation Manager or the SamSetup you will have 
access to the usual help facilities provided by programs running under Windows®. If 
you need to look up a subject and it is not included in the help-file, please let us know 
by fax or e-mail. The help-file will then be updated accordingly on a later release.
5-2       Sound Automation Manager
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514 6DP6HWXS

After you have installed the Sound Automation Manager, it will appear as a new sec-
tion in the program folder of the Windows® Start menu. One of the entries in this 
section is Sam Configuration. Click on this menu entry to run SamSetup. The Setup 
window opens, see fig 2-1.

The first thing you need to do in Setup is to select the console type:

■■■■ In the Setup window, fig 2-1, click on Console in the menu bar.
■■■■ In the drop-down menu, click on Change Console.
■■■■ Select the desired console by clicking one of the options in the dialog box.

Next, enter the number of frames that constitute the console.

FIG 2-1.  The SAM Setup window

&OLFN#&RQVROH &OLFN#&KDQJH#FRQVROH

&OLFN#RQH#RI#WKH#RSWLRQV
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■■■■ Select the appropriate number in the Number of frames menu selection in the 
section Frame totals, see fig 2-2.

Once the console type and number of frames have been selected, select the frame 
into which you want to add modules. If the frame you want to edit is not shown, click 
on the arrow to view the Current Frame menu (see fig 2-2). When you have placed 
modules in each frame, SAM can generate a picture of the console on the VDU 
screen (see fig 2-3). This picture will assist you in entering cue information and get-
ting an overall view of console performance without you having to have access to the 
console itself.

FIG 2-2.  Selecting number of frames to configure.

6HOHFW#QXPEHU#RI#IUDPHV 6HOHFW#IUDPH

FIG 2-3.  In SAM the computer generates a picture of the console on the screen.
tomation Manager Revision SAM2005-2
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In the SAM Setup window, the individual Frame configuration has two columns, 
Fader type and Module type (see fig 2-4). The columns may show up to 64 positions. 
The number in the index column indicates the frame position of each module or 
fader. Use the scroll bar to show more positions. 

■■■■ To select module or fader type, move the cursor over the box in the desired posi-
tion in the module column. 
■■■■ Click in the box. Each click moves on to another module type.

For each module being selected, a corresponding coloured block is added to the 
frame simulation block row at the bottom of the window. A colour key indicating the 
type of module or fader that has been selected is located on the right hand side of 
the window.

Another way of selecting module types is to click-drag in the block row:

1. Move the cursor so that it is inside of the box that contains the frame simulation 
block row.

2. Press and hold down the left mouse button while dragging a box around the 
desired module positions.

3. Release the mouse button when the desired module positions have been 
selected.

4. Click the right mouse button to select module type for the selected blocks.

FIG 2-4.  Select modules by clicking on them and then right-click to show a menu or drag a box around the modules and 
then right-click.

6HOHFW#PRGXOH#W\SH

&OLFN0GUDJ#D#EORFN#RI#PRGXOHV
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If you want to change a selection, you can either: 

■■■■ Click under the coloured block in the row at the bottom of the window to select 
that module, and then right-click to show a menu, see fig 2-4.
■■■■ Drag a box around the desired positions in the block row and then right-click to 
show a menu. Left-click on your choice.

or

■■■■ Click on the box in the desired position in the module column. Each click moves 
on to the next module type.

51415 6DYLQJ#D#IUDPH#FRQILJXUDWLRQ

When all modules for each frame in the console have been added, click on File in the 
menu bar and then click on Save or Save and Exit. The setup program will then write 
a file with mapping information to the computer hard disk. If you select Save and Exit, 
SAM Setup will close down.

If you do not want to keep the setup:

■■■■ Click on File in the menu bar and then click on Exit.

FIG 2-5.  Saving the mapping information.

&OLFN#RQ#)LOH &OLFN#RQ#6DYH#RU#6DYH#DQG#([LW
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Console configuration data can be imported from two sources – the Cue file and the 
Map file. The Cue file contains console configuration data for the show and the Map 
file contains information about various frame configurations.

To import a file with mapping information into SamSetup:

FIG 2-6.  Importing mapping information.

41#&OLFN#RQ#)LOH

51#&OLFN#RQ#,PSRUW

61#&OLFN#RQ#0DS#ILOH#RU#&XH#ILOH

71#6HOHFW#ILOH#WR
LPSRUW1
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When you save a console configuration, to SAM (using the command Save or Save 
& Exit), the configuration data becomes the current setup of SAM. Hence, it follows 
that if you decide to import another configuration to the current setup, the imported 
configuration will overwrite the current one and you will lose the initial configuration 
data, unless you save it as a separate file. To save the initial configuration data, use 
the Export command in the File menu. Data for the current console configuration can 
then be exported to a file that can be retrieved at a later point.

FIG 2-7.  Export a console configuration.

&OLFN#RQ#)LOH

&OLFN#([SRUW#PDS

1DPH#WKH#)LOH

&OLFN#RQ#6DYH
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If you want to undo an Import or GetMaps request (for information about GetMaps, 
see 2.1.8) click on the relevant option in the Undo menu in the file bar of the Sam-
Setup window.

FIG 2-8.  The Undo option.

&OLFN#8QGR &OLFN#RSWLRQ
5-2       Sound Automation Manager



2-8 Set the console configuration

Sound Au
51419 6pDQFH

In order for SAM Setup to be able to communicate with the console, the Séance net-
work port has to be open. To open the port, click on Séance in the menu bar and 
select Open Port.

The greyed out options in the Séance menu become selectable, see fig 2-10.

FIG 2-9.  Open    Seance network port.

&OLFN#6pDQFH &OLFN#2SHQ#SRUW

Verify Network 
6HWWLQJV

&OLFN#2.

FIG 2-10.  The Seance menu.

Click to close port

Click to update, see 2.1.7 
Update Séance

In order to avoid over-writ-
ing essential data, 
extreme care must be 
observed when using 
these options. Further 
information available from 
CADAC.
tomation Manager Revision SAM2005-2
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To update the Seance program, the Séance box needs to be switched ON and a util-
ity called SAM SETUP needs to be run on the PC.

Update the Séance program from SAM SETUP by performing the following steps:

1. In the SAM SETUP main menu click on Séance.
2. Click on Open Port. 
3. In the Network Settings window, make sure that the Séance IP-address is identi-

cal to the one specified in Communication Setup on page 8 in the Séance Instal-
lation & User manual

4. Make sure that the port setting for the Local port is the same as for the SAM 
SETUP port.

5. Make sure that the port setting for the remote port is identical to the one for the 
Séance SETUP port (see Communications Setup on page 8 in the Séance 
Installation & User manual).

6. Click OK.
7. In the SAM SETUP main menu, click on Séance.
8. Select Update Séance.
9. When Update has transferred all the files, press the Version button under the dis-

play window on the Séance box. Check that the display shows correct version 
number, release date and time for update.

If the update has been successful, the Séance will restart using the new executable. 
It is possible to download other files to the Séance box in this way by using the 
Update files option in the file menu.

:$51,1*= Do not add leading zeros into the IP-address (i.e. the address 
194.222.033.011 should be typed 194.222.33.11). If this is not observed, the com-
puter will not communicate.
5-2       Sound Automation Manager
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If you want to update a certain console configuration stored in the CCM, click the 
Maps menu in the menu bar and select PutMaps. In the same way, if you want to 
update the computer configuration with the data from the CCM, click GetMaps.

&OLFN#WR#*HW#0DSV
IURP#&&0

&OLFN#WR#XSGDWH#PDSV
LQ#&&0

FIG 2-11.  Get Maps & Put Maps
tomation Manager Revision SAM2005-2
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614 )LQGLQJ#WKH#6RXQG#$XWRPDWLRQ#0DQDJHU#
SURJUDP

You will find Sound Automation Manager (SAM) in the Windows ® Start menu or you 
can create a SAM short-cut on the desktop.

1. Click on the Windows ® Start-button in the bottom left corner of the screen.
2. The Start menu opens.
3. Click on Programs.
4. Click on the Sound Automation Manager entry
5. In the sub-menu, click on Sound Automation Manager.

The SAM -program starts and a window opens, see fig 3-1. Select windows to view 
from the tool bar.

FIG  3-1.  The main window in Sound Automation Manager

7LWOH#%DU 0HQX#%DU 7RRO#%DUV &KLOG#ZLQGRZ
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When you start SAM, a window called the Parent window opens, see fig 3-1. In the 
parent window you will find the title bar, the menu bar and the tool bars. The rest of 
the window constitutes the work area.

61514 7KH#&KLOG#:LQGRZV

When you click in the menu bar or the tool bars, new windows will open, displaying 
information and giving access to editing facilities. These windows are called the Child 
Windows. Each child window shows a different type of data. There may be as many 
or as few child windows as required. You can change the size and position of the 
child windows to what best suits your current job requirements.

61515 /RFN#9LHZV

If you have opened several child windows, you may want to maintain their locations 
on the screen. Click on Mode in the File bar and then select Lock Views from the 
menu.

61516 7KH#7LWOH#%DU

The Title Bar contains the Program Name, the version number and the name of the 
current show. Other information may be added as you are creating and editing a 
show. This will be described in subsequent sections.

61517 7KH#0HQX#%DU

The Menu Bar is a standard feature of most Windows ® programs and gives you 
access to various displaying and editing functions. Each entry in the menu bar can 
be clicked, causing a drop-down menu to show on the screen. Another way of dis-
playing the drop-down menu is to type the underlined letter in the menu bar entry 
while holding down the Alt-key.

FIG 3-2.  Click the entry in the menu bar to show a drop-down menu.

7KH#0HQX#%DU

'URS0GRZQ#PHQX
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To select from the drop-down menu, click on the function you require. A child window 
with that function will then open.

Another way of accessing a function is to use a short-cut, which is a combination of 
holding down Ctrl + the designated letter key. In the menu, pressing Alt + the under-
lined letter in the menu option, selects that option.

61518 7KH#7RRO#%DU+V,

The Tool bar (see fig 3-3) is another standard feature of Windows ® programs and 
provides short-cuts to most of the main functions in the program. In SAM, some of 
these tool bar icons have a built in function for opening/closing child windows. This 
means that when you click on any of these icons, the icon depresses and a child win-
dow opens. If you click the icon again, the window closes and the icon resumes its 
normal appearance. 

SAM has a number of tool bars for various purposes. These will be described in the 
appropriate section.

61519 )XQFWLRQ#NH\V

The computer functions keys F1 to F6 have different functions depending on what 
view you are in. Function keys F7 to F12 are all associated with recording and play-
ing dynamic cues.

6151: 0RXVH#FOLFNV

Windows ® syntax for using the mouse stipulates the following: 

Left click  – click the left mouse button once1

Right click  – click the right mouse button once

Double click  – click the designated mouse button twice in quick succession2

Shift click  – click the mouse button while holding down the shift key
Ctrl click  – click the mouse button while holding down the Ctrl key
Click drag  – press the mouse button and hold it down while you move the pointer.

FIG 3-3.  The toolbar function keys.
7RRO#EDU#LFRQV

1. Windows can swap the left and right mouse buttons, see Control panel, Mouse in the Win-
dows start menu.

2. You can programme Windows for slower or quicker “double-clicks”, see Control panel, 
Mouse, in the Windows start menu.
5-2       Sound Automation Manager



3-4 Basic Windows® terminology

Sound Au
6151; 7KH#0RXVH#3RLQWHU#6KDSH

In some circumstances, the mouse pointer changes its appearance when moved. 
The change indicates that a certain function is available in that part of the screen. 
SAM uses this standard Windows ® feature in a number of instances. These will be 
described in the appropriate sections.

6151< &RQWH[W#VHQVLWLYH#PHQXV

Some windows display a menu with a small selection of functions that you are most 
likely to use. To access the menu, right-click over the window that is shown on the 
screen. The functions available are associated with that particular window and may 
vary depending on whether any items are selected.
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714 6WDUWLQJ#WKH#6RXQG#$XWRPDWLRQ#0DQDJHU

The various user options in SAM allow you to configure the program to start up in 
accordance with your requirements. The user options determine for instance what 
show to load, whether to place the child windows in the positions they were in when 
last used, etc.

Assuming the user options are still set in accordance with the ones on the installation 
disc, the SAM start-up screen opens, see fig 4-1.

715 7KH#&XH#:LQGRZ

The Cue Window (see fig 4-1) is the primary information area. It shows a list of the 
cues that make up a show. Each cue has a number and a name. The cue number is 
used for controlling the order in which the cues are placed in the list. The cues in fig-
ure 4-1 are numbered 1.00, 2.00 etc. As each new cue is added, the SAM program 
assigns an incremental number to it.

The cue name is to help you keep track of the cues and usually describes what will 
occur in the show when you recall a certain cue. It could be the name of a specific 
part of the show, for instance the name of a song.

The remaining two columns provide information for the dynamics system, see 9.1.2 
Replaying a Mix.

FIG 4-1.  The Sound Automation Manager start-up screen. 7KH#&XH#ZLQGRZ
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When running a show, it is important to know where in the list of cues the show cur-
rently is. To this end, a cursor is moved through the cue list as the show progresses. 
This cursor is called the Current Cue cursor.

There is another cursor in addition to the Current Cue cursor. This cursor is called 
the Edit Cue Cursor and you use it to select a cue that you want to view or edit.

These two cursors have different functions but can be locked together to operate as 
one. When they are locked together, the resulting cursor takes on the appearance of 
the Current Cue cursor.

71614 /RFNLQJ#DQG#XQORFNLQJ#WKH#FXUVRUV

One of the icons in the SAM Toolbar looks like a padlock. Click the padlock to lock/
unlock the cursors. You can also use the lock/unlock options in the Mode menu in the 
SAM menu bar or use the short-cut Keys, Ctrl+L to lock or 
Ctrl+ U to unlock.

FIG 4-2.  The Cue window with the cue cursors.

FIG 4-3.  Click the padlock to lock/unlock the cursors.
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71615 7KH#(GLW#&XUVRU

The Edit Cursor in the Cue Window (see fig 4-4), allows you to move through the 
show and edit each cue as required. The cue that the edit cursor indicates is called 
the Edit Cue. Use the keyboard arrow keys to move the edit cursor in the cue list. As 
you do this, each cue will be displayed in the views available (see fig 4-5). Provided 
the cursors are unlocked, the cue will not automatically be recalled to the console. If, 
however, the cursors are locked, the cursor also serves as a Current Cue cursor and 
consequently the cue will automatically be recalled to the console.

Recall the Edit cue to the console by pressing F3 (available in all View menus, see 
3.2.6 Function keys). Save the console data to the Edit cue by pressing F2 (only 
available in Cue view).

71616 7KH#&XUUHQW#&XH#&XUVRU

The Current Cue cursor (see fig 4-4) indicates the cue that, most likely, represents 
the current state of the console. This is the cue with the data that was most recently 
sent to the console (F3 = Recall Cue) or saved from the console (F2 = Save Cue). If 
console data changes, it will not reflect in the state of the Current Cue. The cursor 
indication merely serves as a reminder of which cue last interacted with the console. 
Use PageUp and PageDn to move up/down in the cue list.

FIG 4-4.  The Cue window.

7KH#(GLW#FXUVRU 7KH#&XUUHQW#FXUVRU

FIG 4-5.  When you select a cue with the edit cursor, the cue will be displayed in the views available. The figure shows 
the fader frame view.
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In locked mode, a few operational characteristics for the cursors change. The arrow 
keys that were used to move the Edit Cursor will become non-functional. Instead, 
use the PageUp and the PageDn keys to control the cursor movement. Pressing 
these keys will also have the effect of recalling the cue to the console and thus, the 
PageUp and PageDn keys take on the functions Previous and Next.

71618 &XUVRU#UHVSRQVH#WR#FRQVROH#FRPPDQGV

When SAM communicates with the console, a number of commands may be issued 
from the CCM (Central Control Module). Using the P and N buttons will recall the 
previous or the next cue. Using the numerical buttons and the SVE and RCL buttons 
will save or recall data to a specific cue. Any of these actions will move the Current 
Cue cursor, irrespective of whether the cursor mode is locked or unlocked. There-
fore, when you want to edit a cue, always ensure the cursors are unlocked before you 

start1. This allows you to have the console in the required operating mode, while 
editing other cues.

717 &UHDWLQJ#D#QHZ#VKRZ

To start a new show, click on the New icon in the toolbar or click on the File option in 
the menu bar and then select New Show. SAM then opens a dialog box, see fig 4-6. 

Enter a suitable name in the white box provided at the top of the dialog box. 
Windows ‘98, 2000, XP and XP Pro allows very long file names so you can be quite 
explicit. Note that there is another box named Other Comments, in which you can 
type in comments relating to the show. These comments will be displayed in the 
Open Show dialog box when you are browsing the shows. For the benefit of other 
users, it may therefore be a good idea to type in descriptive messages here.

The New Show dialog box also displays a brief résumé indicating the console type 
and configuration being used. The résumé will be used later to check against the 
active console configuration. 

When you have entered a suitable name for the show, click the Create button to save 
the current list of cues to the computer hard disk.

1. Alternatively, work in buffered editing mode, see section 7.4.

FIG 4-6.  The New Show dialog box.
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The Cue Numbers controls the order or sequence of the cues. Consequently, chang-
ing a cue number will change the order of the cues. SAM has functions to add, 
delete, move and renumber cues and you access them by right-clicking over the cue 
number or the cue title column.

719 6HOHFWLQJ#FXHV

Before you can edit a cue or cues, SAM has to know which cue or cues you want to 
edit. Click on the cue number in the left-hand column to select. A coloured bar then 
marks the cue, indicating that the cue has been selected (see fig 4-7).

To select two or more cues, proceed as follows:

■■■■ Click on the first cue you want to select.
■■■■ Ctrl-click on next cue.
■■■■ Repeat for remaining cues.

To select a block of cues:

■■■■ Click on the first cue in the block of cues you want to select.
■■■■ Shift-click on the last cue in the block of cues you want to select.

To remove the selection bar, click in an unused area of the cue window or press Esc 
on the keyboard.

FIG 4-7.  A bar indicates the selected cue.
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You may save data to a cue in two ways:

■■■■ Press the F2 function key to save data to the current cue.
■■■■ Press shift + F2 to save data to a specified cue.

71915 5HFDOOLQJ#D#FXH

To recall a cue, you may either:

■■■■ Press F3 to recall the current cue.
■■■■ Press shift + F3 to recall a specified cue.
■■■■ Right-click in the Cue Window and select Recall Cue from the menu.

FIG 4-8.  Recalling a cue 6HOHFW#5HFDOO#&XH
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You can add a cue to the existing show by:

■■■■ Press the F5 key/click on its icon or press Insert to insert a new cue immediately 
after the Edit Cue, or

■■■■ Right-click in the Cue View to show a menu (see fig 4-9). 
■■■■ In the menu, select New Cue to add a new cue to the END of the cue list.

The new cue will be given the next sequential whole number.

To add a new cue somewhere into the middle of the cue list:

■■■■ Select a cue by clicking on its name (a coloured bar appears at the left-hand side 
of the window). 
■■■■ Right-click to show a menu. 
■■■■ In the menu, click New Cue.

SAM will insert a new cue after the one you selected, and give it an appropriate 
number.

Note that the smallest gap allowed between cues is 0.01. Therefore, if you try to add 
a cue into a gap that is already as small as it can be, SAM will add the cue with a # in 
the cue number column. To give the cue an appropriate number, use the renumber or 
move functions as described below.

FIG 4-9.  Adding a cue 
to an existing show.

&XUUHQW#FXH

5LJKW0FOLFN#LQ#WKH &OLFN#1HZ#FXH
&XH#ZLQGRZ#WR
VKRZ#D#PHQX

(GLW#FXH

FIG 4-10.  Adding a 
new cue after a select-
ed cue.

6HOHFW#D#FXH 5LJKW0FOLFN#LQ#WKH#ZLQGRZ &OLFN#1HZ#FXH
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Adding one or more cue(s) between cue 4.00 and 5.00 will result in a cue with a dec-
imal number. If you add many new cues, the cue number structure may become too 
complex. To avoid this, you can renumber the cues.

To renumber cues:

■■■■ Select the cues you want to renumber using shift-click or Ctrl-click (see section   
3 Basic Windows® terminology).
■■■■ Right-click in the cue window to show a menu.
■■■■ In the menu, click on ReNumber.

FIG 4-11.  Renumbering cues.
6HOHFW#D#FXH 5LJKW0FOLFN#LQ#WKH#ZLQGRZ &OLFN#5H1XPEHU

127(=#6$0#ZLOO#UHQXPEHU#WKH#FXHV#WR#ZKROH
QXPEHUV#DV#IDU#DV#WKDW#LV#SRVVLEOH1#7KHUH#DUH
VRPH#H[FHSWLRQV#WR#WKLV1#)RU#LQVWDQFH/#LI#\RX
ZDQW#WR#UHQXPEHU#FXHV#8133/#8143#DQG#9133/#WKHQ
FXH#9133#FDQQRW#EHFRPH#FXH#:133/#EHFDXVH#WKDW
FXH#QXPEHU#DOUHDG\#H[LVWV1#,I#\RX/#KRZHYHU/
KLJKOLJKW#FXHV#8133#WR#WKH#HQG/#WKHQ#DOO#FXHV#ZLOO
EH#UHQXPEHUHG1
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Use the function Move if you have created a cue, or a number of cues and would like 
to have the cue or the cues in a different order.

To move a cue, or a group of cues, you can either use the following steps or the 
method described in 4.6.6 Moving cues using Cut and Paste”:

1. In the Cue Window, see fig 4-12 below, select the cue or cues to be moved (the 
selected cue or cues indicated by a bar on the left).

2. Right-click to show a menu.
3. In the menu, click Move to show a dialog box.
4. In the dialog box, type in the number of the new position in the cue list. If you are 

moving a group of cues, this number will be assigned to the first cue in the group.

The cue or the cues will be moved to the new position(s) and renumbered accord-
ingly.

Attempting to move a cue to a position already in use generates an error.

FIG 4-12.  Moving cues in the cue window.

6HOHFW#D#FXH 5LJKW0FOLFN#LQ#WKH#ZLQGRZ 6HOHFW#0RYH#&XH
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In addition to the procedure described in 4.6.5 Moving cues in the Cue window, you 
can move cues using the Copy, Cut and Paste functions, available in the Edit menu 
or via the short-cuts Ctrl-C, Ctrl-X and Ctrl-V. (C=Copy, X=Cut and V=Paste).

1. Select the cue or cues to be moved, see 4.6.4 Renumbering cues.
2. In the menu bar, click on Edit to show a menu.
3. In the menu, click on Cut.
4. Click Yes in the Delete Cue Warning window.
5. In the menu, click on Paste.
6. Move the pointer to the new position in the cue list.
7. Left-click with the mouse.

The cue, or the cues, will be moved to their new position(s) and renumbered accord-
ingly.

Attempting to move a cue to a position already in use generates an error.

FIG 4-13.  Moving cues using the Edit menu.

&OLFN#(GLW &OLFN#&XW#FXH &OLFN#<HV 0RYH#FXH#WR#QHZ#SRVLWLRQ
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If you have added cues to the show and at a later stage find that you do not want to 
keep them, proceed as follows:

■■■■ Select the cue or the cues
■■■■ Right-click in the cue window to show a menu.
■■■■ In the menu, click on Delete.

or select the cue in the Cue Window and press Delete.

The selected cue or cues will be deleted.

71: (GLWLQJ#WKH#FXH#WLWOH

To edit the cue title, double-click the left mouse-button on its entry in the cue window. 
A dialog box opens, see fig 4-15  below. Enter the new cue title in the white box pro-
vided.

Another way of editing the cue title is to select Edit Title from the Edit Menu. 

■■■■ Click on Edit in the File bar and then click on Edit Title. 

This option requires the cue to be selected by the edit cursor in the cue window. If 
the cue is not selected, you may click on the next option in the menu: Edit Title List 
and then select the cue title you wish to edit.

If you want to have the cue in a specific colour, tick the box Use Custom Colour in the 
window.

■■■■ Note that you can set the title colour for multiple selected cues by right-clicking-
ing in the Cue Window and then select Set Colours from the menu.

FIG 4-14.  Deleting a cue. 6HOHFW#D#FXH 5LJKW0FOLFN#LQ#WKH#ZLQGRZ &OLFN#'HOHWH

FIG 4-15.  Editing the cue title.
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By using the Undo option in the Edit menu you can undo some commands issued in 
SAM.

■■■■ In the menu bar, click on Edit.

A drop-down menu is displayed.

■■■■ In the drop-down menu, click on Undo.

The action you have performed is cancelled, and the show returns to its previous 
state.

If you undo something and then discover you did not want to undo it after all, proceed 
as follows:

■■■■ In the menu bar, click on Edit.
■■■■ In the drop-down menu, click on Redo.

Your actions are cancelled and the show returns to its modified state.

71;14 8QGR#/LVW

Click on the upper Undo entry in the Edit menu (see fig 4-16) to open a dialog box 
(see fig 4-17 below) listing the contents in the Undo buffer including details of what 
has been changed. Any entry in the list can be selected to show more details in the 
status lines at the bottom. By selecting an entry in the list, you may undo or redo any 
action performed on it.

FIG 4-16.  The Undo/Redo function.

&OLFN#RQ#(GLW &OLFN#RQ#8QGR

FIG 4-17.  Undo list
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 In the Edit menu, you will, in addition to the previously described functions -, Undo 
and Redo, also find Cut, Copy and Paste, see 4.6.6 Moving cues using Cut and 
Paste. For instance, using the option Cut, lets you cut out a cue from the show and 
then paste it back to another position. Similarly, Copy copies a cue to another posi-
tion.

1. Select the cue you want to cut.
2. In the menu bar, click on Edit.
3. In the drop-down menu, click on Cut.
4. In the menu, click on Paste.
5. The line in the cue list where the pointer is now takes on a different colour. Move 

the pointer to the new position in the cue list and left-click with the mouse.

The cue is moved to a new position in the cue list.

If you want to copy a cue to another position in the cue list:

1. Select the cue you want to copy.
2. In the Menu bar, click on Edit.
3. In the drop-down menu, click on Copy.
4. In the Menu, click on Paste.
5. The line in the cue list where the pointer is at now takes on a different colour. 

Move the pointer to the new position in the cue list and left-click with the mouse.

A copy of the cue is added to the cue list and given a number incremental to that of 
the preceding cue.

FIG 4-18.  Moving and copying cues to other positions using Cut, Copy and Paste.

6HOHFW#D#FXH &OLFN#RQ#&XW#FXH &OLFN#RQ#3DVWH

/HIW0FOLFN#WKH#QHZ#SRVLWLRQ
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6RXQG $XWRPDWLRQ#0DQDJHU

814 6WDUW0XS#RSWLRQV

SAM has a number of start-up options. By clicking the Options menu and then Start-
up, these options can be viewed and changed. A check box on the left-hand side of 
each option indicates whether the option has been selected. Click the box to select/
deselect the option.

■■■■ Select Reload last show to open the show you were working on, when you last 
used SAM.
■■■■ Select Reload Windows Placement to have the child windows resume the posi-
tions they were in when you last closed the application.
■■■■ Select Last User Settings to restore the options of the person last using SAM.

FIG 5-1.  Select Start-up options.

&OLFN#2SWLRQV &OLFN#6WDUW0XS

&OLFN#WR#VHOHFW2GHVHOHFW
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Users can have their own settings for screen layout and colours. Instructions on how 
to change these settings can be found in 5.4 View Properties. Select, add or edit the 
name of a user by clicking the Options menu and then clicking Select User. 

■■■■ Click Add New if you want to add a new user.

A new window Add User is displayed.

■■■■ Type in the name of the new user and click OK.

The New User will initially have the same settings as the default user, but any subse-
quent changes will be stored in a separate user set-up file. This means that the next 
time you start SAM, the program will configure itself in accordance with these set-
tings (provided the option Set last user setting at start-up has been ticked, see 5.1 
Start-up options).

To change settings for screen layout and colours, see 5.4 View Properties.

FIG 5-2.  Select, add, edit or delete a User.

&OLFN#2SWLRQV &OLFN#6HOHFW#8VHU

&OLFN#$GG#QHZ

(QWHU#1HZ#XVHU
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Clicking this option in the Options menu in the menu bar displays the User Properties 
dialog box. The dialog box has five tabs, each of which when clicked, will display self-
explanatory options that can be selected by ticking the associated check-box.

FIG 5-3.  User properties dialog box.

&OLFN#2SWLRQV &OLFN#8VHU#SURSHUWLHV

7KH#8VHU#SURSHUWLHV
GLDORJ#ER[#RSHQV
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81714 7KH#*ULG#FODVV#9LHZV

You can configure the way SAM displays information on the screen. In the Options 
menu, click on View Properties to open a new window that shows various parame-
ters you can change. By clicking on the tab labelled All Views, you can set the com-
mon properties for all windows. Each window then has its own tab that may be 
clicked so that additional features can be controlled. 

The  views displayed in this manner are referred to as the Grid Class Views and 
comprise those child windows that display their data in rows and columns. Each row 
and column in the Grid Class Views have a “header tile”.

The child window row header shows the cue number and the column header shows 
a suitable name which describes the data in the column. In many cases this data is 
editable as part of the show file. Editing is done using the Options->View Properties 
menu selection, which calls up the View Properties dialog box. The dialog box can 
also be accessed by right-clicking over the column header and then select Properties 
from the pop-up menu. 

The left-hand area of the dialog box gives you control over the columns and the way 
they are shown. You can make columns invisible by unticking the relevant box. The 
next box enables you to change the column width and the text is shown in the column 
header. The column width can also be changed by right-clicking in the header box, 
then choose Column Width from the pop-up menu followed by entering the size in 
the associated window. To set the width for multiple columns, click a column to select 
it, then use Ctrl-click or Shift-click to add any other columns you want to resize. 
Right-click on each column and set the size as previously described.

If you click once on a row in this area it will be highlighted and its name can be edited 
in the box at the bottom.(Where editing makes no sense, this area is greyed out).

&OLFN#2SWLRQV &OLFN#9LHZ#SURSHUWLHV

FIG 5-4.  Change View properties.

FIG 5-5.  Dialog box layout

&RQWURO#FROXPQV#DQG#WKH
ZD\#WKH\#DUH#GLVSOD\HG

2SWLRQV2&RORXUV#VSHFL
WR#RQH#ZLQGRZ
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The right half of the dialog box provides options/colours that may be set specifically 
for one window. These options are generally Show Row Lines, Show Column Lines, 
Font Size and Vertical Cell Header.

To change settings for the remaining windows, click on the associated tab and repeat 
the procedure. All changes will be saved when you close down and restored the next 
time you open SAM

81715 +LGLQJ#&ROXPQV

Columns can be hidden, either via the dialog box on the previous page or by right-
clicking on the column header followed by selecting Hide from the pop-up menu. If 
you make a column invisible, this will be indicated by the corner of the adjacent col-
umn being folded down. Right-clicking the column header with the folded down cor-
ner and selecting Unhide Next from the pop-up menu will make the column visible 
again.

81716 0RYLQJ#FROXPQV

The order of the columns can be changed by right-clicking the column header fol-
lowed by selecting Move Right or Move Left from the pop-up menu.

81717 (GLWLQJ#IHDWXUHV

The Grid Class Views editing facilites for copying and pasting data between cells, 
rows or columns, work in a fashion similar to that of Microsoft Excel as this will be 
familiar to most users. You select row/column by clicking on the row/column header. 
Select cells by clicking on them. Multiple selections can be made using Shift-click or 
Ctrl-click. A block can be selected by dragging out a boundary box. Selections can 
be cancelled by clicking another selection or an area that does not contain cells.

You can mark a selection for copying using Ctrl-C or the copy option on the Edit 
menu. The marked selection will then be shown with a dotted line around it. Then the 
data may be copied to a region selected elsewhere, by using Ctrl-V or the Paste 
option on the Edit menu. The “mark for copying” may be cancelled by pressing Esc.

The region you want to copy something to, must, in most cases, be of the same 
shape as the region you copy from, i.e.same number of rows by the same number of 
columns. If this is not so, SAM will raise an error message. Also, there may be func-
tions in the right-click menu to enable you to perform functions globally on the 
selected cells. These functions are specific to the particular view.
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The information stored by SAM is kept in different files and directories. To specify the 
directories, click on Options in the menu bar and then click Directories to open a new 
window labelled Configure.

1. In SHOW, you keep the shows. Each show constitutes a directory containing all 
files associated with that show.

2. In SETTINGS, you keep the operational settings like the ones you performed in  
5.3 User Properties.

3. In BACK-UP, you can specify a different directory, drive or device for making 
back-up copies of the show, user settings etc.

4. In USER you specify where User Setup files are stored.

In order to avoid affecting SAM’s ability to find the required files associated with 
Show or User Settings the next time you run SAM, be careful when changing these 
directories.

819 &RPPXQLFDWLRQV

81914 2SHQ#FRPPXQLFDWLRQV

In the dialog box in fig 5-7 enter the appropriate values in the boxes provided (see 
Communications Setup in the Séance User Manual).

FIG 5-6.  Specifying the directories.

&OLFN#2SWLRQV &OLFN#'LUHFWRULHV

FIG 5-7.  Specifying the directories.
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The Tracking feature allows a backup PC to run through its show file in step with the 
main PC, so that in the rare event of a failure, the backup PC is already at the right 
point in the show so that it can take over smoothly.

The system works by sending a message containing the Cue number via a serial 
connection. The backup PC receives this message and moves its show cursors to 
the relevant cue if it exists.

Tracking can operate through network connections. When Network is selected from 
the Comms menu, an additional box appears into which you enter the IP-address of 
the other computer. The IP-address of the current computer is shown at the bottom 
of this box, thus making it easier to transfer IP-addresses between two computers.

81916 5HPRWH#&RQWURO

The comms menu includes an option for remote control (see fig 5-8). Its function is 
similar to that of the Tracking feature, but the controlled PC actually recalls the cue. 
This enables two (possibly dissimilar) consoles to be controlled from one position by 
remote controlling one as a slave. Since the function of this system is based on cue 
numbers, the slave system does not have to have all the same cues as the Master 
system. Messages received with a non-existent cue number will be ignored.

Remote control can be applied through network connections. When Network is 
selected from the Comms menu, an additional box appears into which you enter the 
IP-address of the other computer. The IP-address of the current computer is shown 
at the bottom of this box, thus making it easier to transfer IP-addresses between two 
computers.

FIG 5-8.  The Tracking feature dialog box
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914 2SHQ#ODVW#VKRZ

When starting SAM, the program allows you to have the last show you were working 
on automatically re-opened, (see 5.1 Start-up options). For a show to be opened, it 
must first have been saved (see  6.3 Saving a show).

915 2SHQ#D#QHZ#VKRZ

To open a new show, click on File in the menu bar and then click Open. A dialog box 
opens.

■■■■ Click on a show to highlight it and display information in the Preview part of the 
window.
■■■■ Click twice on the show to open it or click on Open.

If the current show has been modified and not saved, SAM will warn you before 
opening the new show.

All Windows® programs allow you to right-click an option and bring up a menu with 
various file handling options, such as Send To, Delete, etc. Use these options with 
care, since Windows® has no specific way of dealing with details of CADAC show 
directories and therefore may alter a show in a way that makes it impossible to re-
open it.

Note that this window may display:

■■■■ SAM shows
■■■■ CGC shows
■■■■ Directories

each of which is treated differently when double-clicked.

FIG  6-1.  The Open show dialog box.
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You save shows using the Save or Save As… functions, available in the File menu. 
Use Save for a show that already exists on the computer hard disk to update its 
associated files with the latest information.

When you save a show for the first time, or save a show under a different name, you 
use the Save As… function.

When you click Save As… a dialog box opens, see fig 6-2.

Enter the show name in the upper box in the window. Note that the name must com-
ply with Windows® rules for filenames. The bottom box is intended for a short, 
descriptive comment, see the Comment area in the Open Show dialog box (see 
fig 6-1). The middle part of the dialog box shows the console configuration.

FIG  6-2.  Using the Save As... function.

&OLFN#6DYH#$V111

(QWHU#VKRZ
DQG#VDYH
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To make a backup of the current show, click on the File option in the Menu Bar and 
then select Backup. A dialog box opens (see fig 6-3) prompting you to enter where 
you want the backup to be stored, and which parts of the show/setup that you want to 
include. If you do not wish to use the default directory (specified in Directories in the 
Option menu) click on Browse to select another directory. When you have entered 
your choices, simply click on Backup.

91615 5HVWRUH#6KRZ

To restore a show, click on Browse and select the directory that contains the show 
you want to restore. Then, by checking the relevant boxes in the dialog box, select 
which parts of the show/setup you want to restore. Finally, restore the show to the 
directory of your choice (specified in the Restore To box), by clicking on Restore.

Click on Backup Show

Click on Backup

FIG  6-3.  Backup Show dialog box

Click on Restore Show

Click Restore

FIG  6-4.  Restore Show dialog box
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Export and Import facilities using CSV-files (comma-separated variables) are avail-
able via the File menu for the console layout (map) and names assigned to each 
module position. Try for example SAM’s export facility to see the format expected of 
the file, after which you could use your favourite program to create a similar file to 
import into SAM SETUP or SAM.

918 6KRZ#DQG#FRQVROH#PDSSLQJ#FRQIOLFW

If you try to load a show that has been saved with a different mapping than that of the 
current console, SAM will display a dialog box labelled Show and Mapping conflict, 
see figure 6-5. For details on the options in the dialog box, see sections 6.6 Load 
from console, 6.7 Load from show and 6.8 Re-mapper.

919 /RDG#IURP#FRQVROH

When a show is saved, the console configuration is saved as part of the Cue file. 
This allows SAM to determine whether the saved configuration is different to the cur-
rent console. If it is, SAM re-arranges the data for the new console. The mapping 
may not always be the same since different modules require different data, but this 
method is usually much quicker than re-plotting the whole show from the beginning. 
When re-mapping has been carried out, SAM indicates this in the title bar, see fig 6-
6  below.

In some cases, the show cannot be automatically translated into the current console 
configuration. If this occurs, the option “Load from console” is greyed out (as in figure 
6-5).

FIG  6-5.  The dialog box Show and Console mapping conflict.

FIG  6-6.  Title bar indicating re-mapped console.

Console configuration re-mapped
tomation Manager Revision SAM2005-2



Opening and Saving shows 6-5

Revision SAM200
91: /RDG#IURP#VKRZ

Use this option to override the current setup of SAM and to configure the console in 
accordance with the mapping that is contained in the show file. This is a temporary 
feature and SAM will revert to its original console layout next time it is run. 

91; 5H0PDSSHU

SAM features a new function called the Re-Mapper. The Re-Mapper allows you to 
re-organise (Re-Map) shows designed on one console to suit another console with 
different modules. The Re-mapper can be invoked in two different ways:

■■■■ When opening a show, SAM detects that the Show configuration and its own 
configuration are different and offers the Re-Mapper as one option to resolve the dif-
ference.
■■■■ Select Re-Mapper from the File->Remap…  option.

91;14 5H00DS#XSRQ#RSHQLQJ#D#6KRZ

If the console configuration is different to that of a show, the Re-Mapper opens a dia-
log box that looks similar to figure 6-7.

The dialog box displays two rows of coloured blocks, similar to the row shown in 
SamSetup. As in SamSetup, the coloured blocks represent the arrangement of fad-
ers and modules in a console. The top row represents the console that the show was 
designed on (the “Show”) and the bottom row represents the present console config-
uration (the “Console”). On opening the show, SAM compares the two “maps” to 
ensure that each position in each frame has the same type of module and fader for 
both the Show and the Console. In this case, SAM indicates in the “Bad Links” and 
“New Blank” boxes that there are differences.

A Bad Link  indicates a fader or module in the Show that has no equivalent in the 
Console. The data for the show module cannot be automatically transferred and so 
will be lost.
A New Blank  indicates a fader or module in the Console that does not have an 
equivalent in the Show and so no data is available for it. Thus, it will be filled with 

FIG  6-7.  Re-mapper opening dialog box.
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Bad Links and New Blanks usually occur in pairs, see fig 6-8. In the figure, nine non-
motorised faders, originally used in the Show, have been replaced with motorised 
faders (the dark blue and light blue blocks in the Show and Console respectively).
The linking from Show to Console can be examined by ticking the box Show All 
Links, see fig 6-8 .

Each position has a “link line” drawn from the Show to the Console, some are cyan 
and some are dark blue. Three buttons in the bottom left of the dialog box allow you 
to examine links for Faders, Modules or (as above) Both.

Viewing just the fader links shows the changes. Since the Show used non-motorised 
faders and the Console now has motorised faders, the first nine faders do not show 
“link lines”.

FIG  6-8.  Position “linking”.

FIG  6-9.  Fader links only.
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Once you have established where the Console differs from the Show you can convert 
or translate the original show data to make it suitable for the replacement faders. This 
translation will be more or less complete depending on which type of fader/module is 
the source and which type is the target.

To create a link we perform the following steps:

■■■■ Select one or more faders/modules in the Show configuration by clicking on the 
coloured box (-es) with the left mouse button. Shift-clicking and Ctrl-clicking may be 
used to form multiple selections.
■■■■ In the Console configuration, click on the fader/module to which you wish to 
make the link. In the case of multiple selection you only need to select the first fader/
module, the rest are implied by the size of the group selected in the Show. 

NOTE: The linked fader/module does not have to be the one in the same frame posi-
tion. Clicking the button labelled Make will create the links.

When all the required links have been created, the Bad Links and New Blanks 
counters show zero. 

When all links have been made, click the OK button. SAM will run through the cues 
of the show being opened and change the data as required to accommodate the new 
modules.

FIG  6-10.  Selected faders, ready to make links.
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Sometimes the map of the Show and the Console are identical but you wish to move 
modules from one place in the frame to another. For example, you may wish to bring 
the controls for one actor or instrument closer to the centre of the console. If you 
move an actors microphone from say channel 1 at the extreme left of the console 
and plug it into say channel 9 (near the middle) the recorded cue data for these 
channels would be incorrect. With the Re-Mapper, you can move the data recorded 
in the cues for channel 1 so that it is now recalled to channel 10.

The Re-Mapper dialog box opened by clicking File->ReMap…  shows that all faders 
and modules in the Show are linked to the corresponding fader/modules in the Con-
sole. You can however break links and remake them in a different order. Figure 6-9 
shows channel 1 and channel 16 and also channel 2 and 51 linked to swap the data
This is a very simple example of what could be a very complex rearrangement proce-
dures

91;17 6DYH#DQG#/RDG#OLQN#ILOHV

If several different shows requires the same translation and the translation requires a 
complex set of cross-links, saving the link-set as a file will make things easier and 
save time. To save a link-set, click the Save Links  button. Later you can reload this 
link-set by clicking the Load Links  button and thus, apply the rearrangement to 
another show.

91;18 7UDQVODWLRQ#DQG#SDUWLDO#WUDQVODWLRQ

In some cases, using the Make a link  feature in the Re-Mapper, generates a brief 
summary of the translation on the screen, see fig 6-12 opposite.

This report may give details of what has been translated and, more importantly, what 
has not. It may be that an item that exists in the Show module does not have a corre-
sponding item in the destination module, thus resulting in the translation being only 
partially done

FIG  6-11.  Moving faders/modules within a show.
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91< :KDW#FRQVWLWXWHV#D#VKRZ#RQ#WKH#KDUG#GLVN

When working in SAM, it may seem as though the show constitutes just one file, 
since most of SAM’s functions treat it as such. From a technical point of view how-
ever, a show is a directory with many files in it, so when saving a show, SAM creates 
a directory and saves various files into it. The simplest show has at least two files: 
Showname.Cue and Sam.Cfg.

91<14 6KRZQDPH1&XH

This file holds the list of static cues. A static cue is a cue that acts instantaneously;, 
fader snap shots, MIDI, EVENTS etc. Backup-files are saved as *.BAK files.

91<15 6DP1&IJ

All show files contains this file. SAM uses it to distinguish between directories, so 
that a certain directory can be recognised as being a show. The file contains general 
configuration data, for example console size, MIDI and Event names. 

91<16 -10,;

Files containing information about dynamic mixes are stored as *.MIX files. The con-
tents of these files can be viewed using the DOS-utility WALK.EXE.

91<17 2SHQLQJ#D#&*&0VKRZ

CGC-shows are saved in DOS-format and therefore have to be translated into an 
appropriate form before SAM, operating under Windows®, can open them. In some 
cases, this may result in an incomplete translation, which therefore requires the show 
to be remapped for setup (see 6.8 Re-mapper).

FIG  6-12.  Translation report.
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:14 2SHQLQJ#WKH#'DWD#(GLWLQJ#ZLQGRZV

The cue data is displayed in various child windows, accessible via the toolbar at the 
top of the SAM main window. The child windows containing fader and module data 
are referred to as the frame windows.

There are as many windows available for the fader frames and module frames, as 
there are frames in your console(s) as selected in SAM Setup. Each frame window 
can be accessed by clicking the Console View button in the tool-bar - see fig 7-1 
below.

In addition to the console view, there are views for MIDI, Events etc., see sections 8 
MIDI features, 8.8 Events and 7.4 Naming the console modules. Each icon opens or 
closes a window, displaying the associated data. The icon appears to be in a down 
position when the window is open and raised when closed.

FIG 7-1.  SAM’s toolbar.

Console View

Module Frame View
Fader Frame View
Master Title Data Base View
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To view fader data, click on one of the fader frame icons. This displays a fader frame 
window with a picture of the console faders, see fig 7-2. Note that when SAM first 
loads a show, the Cue window does not show the cursors. Press the PageDn key on 
the keyboard to have the cursor move onto the first cue. The fader frame views can 
then display the cue data.

The types of faders and their positions in the frame are determined by the selections 
in SAM Setup (see section 2 Set the console configuration).

When you recall a cue, the fader frame window and any other open window associ-
ated with the cue, will display the cue contents. The amount of data available 
depends on the console type and the type of modules in it. Generally, the channel 
faders have a VCA-group and switches for Mute and Aux. Some fader types have 
more switches. In the case of motorised faders, the fader knob also changes position 
to show the recorded level.

Left-clicking with the mouse over a fader selects that fader. A green icon with red 
arrows above the fader indicates this. Shift-clicking or Ctrl-clicking selects further fad-
ers. Some data items can be entered directly using the quick keys, described in the 
following section. More extensive editing can be performed through the Fader Detail 
window (see 7.2.1 The Fader detail window).

FIG 7-2.  The SAM toolbar and the fader frame view.

61#7KH#)DGHU#IUDPH#ZLQGRZ#RSHQV

41#&OLFN#RQ#&RQVROH#9LHZ

51#&OLFN#RQ#WKH#)DGHU#IUDPH#LFRQ
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If you double-click on the selected fader, a fader detail window opens.

The Fader detail window offers a larger display of the faders. The associated controls 
can be clicked or dragged to change the data. 

In the fader detail window, you can:

■■■■ Click and activate individual functions and see how the LEDs switch on and off. 
■■■■ Drag the fader knob to a new position.
■■■■ Enter an alphanumeric title for each master fader in its associated Edit Box.
■■■■ Use the Quick Keys to enter or change data items.

The facilities vary according to the console faders., They do however follow the same 
style.

In circumstances where the destination of a key press is ambiguous e.g. a module 
with several MUTE sections, individual items within the fader can be selected. The 
item can then be selected and so receive the key presses.

FIG 7-3.  The fader detail window.

'RXEOH0FOLFN#RQ#WKH#IDGHU

&OLFN#RQ#IXQFWLRQV#WR#HGLW#WKH#FXH

UICK KEYS
ou can use the keys below to 
nter data into the selected 

ader(s):

eft arrow: Selects next fader to 
he left
ight arrow: Selects next fader to 

he right
-9, A-F:  If the fader has a 7-seg-
ent display, this button updates it
: Toggles the MUTE
:  Toggles the Aux/VCA

hese keys work for frame views 
nd detail views.
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The facilities in the module frame windows are the same as those in the fader frame 
windows, although the functions provided are usually significantly different. As far as 
data is concerned, they are essentially on/off switches or rotary encoders.

You can open the Module Frame views by clicking the Module Frame icon in the Con-
sole view, which is accessible via the toolbar (see fig 7-1).

If a potentiometer is programmable, then clicking and holding the mouse button will 
open a “tool-tip” showing the value for the potentiometer. Dragging the mouse will 
vary the value - up or to the left will increase, and down or to the right will decrease 
the value. Moreover, if the potentiometer is of dual-gang type, then the left mouse 
button varies the “upper gang”, while the right mouse button varies the “lower gang”. 
The tool-tip can be locked to the potentiometers position or, alternatively, move with 
the mouse. You can set this option in User Properties -> Edit Options. 

Real-time updating may optionally function across all controls for all modules. If a 
value is changed in the Current Cue, then it will automatically be sent to the console 
as an update. If a control is dragged, then the transmission rate for messages can be 
set according to the computers processing power. This option can be found in User 
Properties -> Edit options.

7RRO7LSV#DUH#GLVSOD\HG#ZKHQ#\RX#OHDYH
WKH#SRLQWHU#KRYHULQJ#RYHU#D#FHUWDLQ#DUHD

'RXEOH2FOLFN#RQ#WKH#PRGXOH#WR#
RSHQ#WKH#GHWDLO#ZLQGRZ

FIG 7-4.  The Module frame window and the module detail window.

Tool Tips

When you move the pointer around 
in the frame windows and let it 
hover over a certain area for a sec-
ond or two, a small box called a 
ToolTip, pops up. The ToolTip may 
indicate module number, title 
strings etc.

In the module detail window, Tool- 
Tips are used to show the level set-
ting recorded for potentiometers 
with nulling facilities. In some 
cases, you can double-click on the 
potentiometer to open a dialog box, 
into which you can enter a new 
value for the selected potentiome-
ter.
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The module names list allows each module (channel, group etc.) to be given a name, 
describing the Character, Actor, Instrument or Effect that is being processed.

As many or as few Names needed can be added to the list by right-clicking over the 
column headers and selecting New Module Name from a pop-up menu. Then, fill in 
the Frame Number and Slot Number. Slot numbers start at 1 at the left hand side of 
the frame and increment for each single width module space up to a maximum of 63 
at the right hand side of the frame.

Alternatively, you can use the function “Collect Mappings” from the same menu. This 
will create a Name for each slot in the console. Name column 1 will be filled in with 
the default name, which then may be edited as required.

There are up to 8 names columns, so each module slot may have several aliases, 
where, for instance, one actor plays several minor parts and each module/fader can 
be assigned to a Set or Sets for grouped operations. See 7.5 Fader/Module Sets for 
details.

The process of giving each channel a name that will be displayed in a tool-tip or sim-
ilarly appear on the screen may seem a bit tedious. However, the time put into this is 
justified in that you now can assign the Module Names via a menu system in the 
Master Title View. The named channels are then automatically assigned to the cor-
rect VCA group - see section 7.4.1 for details.

FIG 7-5.  Module Name List
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The advantages of the Module Name List become obvious as you begin entering the 
names for the VCA Master faders in the title DataBase view, for example: Channel 1 
has been named Santa Claus and this name is then entered as the first title for DC 
master #3. This is shown in the tool-tip appearing in the Frame view.

The channel name can now be entered as a DC Master Title using the menu system 
in FIG 7-7. Entering a channel name as Title for DC Master 3.

When you have entered the DC master Title, channel 1 will automatically be 
assigned to VCA Master 3. Of course, the ripple-through effect applied to the Master 
Titles means that the VCA assignment will also ripple through in the Faders. 

Clearing the DC Masters Title, using the menu CLEAR feature, will set the channel 
VCA assignment to zero. It is worthwhile keeping in mind that there are User func-
tions that will apply or remove the Mute, when setting the VCA to, or, away from zero; 
hence it should be clear how this feature can be a time-saver when building the Cue 
structure for a show. Once the Module Names List has been set up, assigning VCA 
settings to channels is just a matter of selecting a name from the list available in the 
Master Title DataBase View.

NOTE: This feature only works when the text is entered and removed from the Mas-
ter Title cells, using the menu features. If you simply type the name in, or delete 
using the backspace key; SAM won’t be able to maintain the link between the mod-
ule Name and the VCA assignments. Consequently, any changes to the Real Text 
names will revert them to Manual Text and they must be re-inserted from the Menu 
List to get back the Auto assignment.

FIG 7-6.  The name shown in a 
tool-tip

FIG 7-7.  Entering a channel name 
as Title for DC Master 3

FIG 7-8.  The ripple-through effect 
of VCA assignment in faders.
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If the show contains several channels to which you are going to apply the same data, 
you may find it useful to arrange the channels as sets and then apply the changes 
collectively. This may be the case if, for instance, you have a large choir on stage split 
into a male and a female part, further divided into baritones, tenors, sopranos and 
altos. By assigning a number of channels to a set, you will save time when applying 
data and also make sure that the same data will be applied throughout the set. To 
this end, the Sound Automation Manager software features the option Channel Sets.  

Enabling and Naming of the sets is performed in the Module Name List View. One 
way to access this view is to click Open Module Name List view. You can also click 
Consoles in the View menu of SAM. This will open the Console View, from which you 
then select Module Frame View. Remember that the menu options vary with the dif-
ferent views, so when you click View in SAM’s menubar while in Module Frame View, 
you will get access to the menu option Module Text.

Having used one of the above methods, the Module Name List window opens, see 
figure 7-7 above. Next, tick the box “Enable Channel Sets” - each set can then be 
enabled so that SAM only displays the sets you need. To enable a set, tick the box 
next to the chosen set. You also can edit the names of a set by clicking in the text box 
for the set and type in a suitable name.

The selected sets are indicated below the faders in the Fader frame View -               
see fig 7-10).

The members of a set are displayed as coloured tiles - see figure 7-10 above, which 
contains eight sets. Each set has its own designated colour. To assign a channel to a 
set, click on the tile of the appropriate set below the channel (or clicking it again to 
cancel).

Once you have set up membership of the sets, you can quickly select the faders/
modules you want to work on. Right-clicking with the mouse on a set brings up a 
menu, from which you can access further parameters, Select Set, Remove All from 
Set and Show Key. The latter shows the colour and name for each set and is super-
imposed on other windows to assist your memory when using the sets.

NOTE: If the check box Disable Edit of Channel Sets in the Channel Sets dialog box 
is ticked, the click selection will not have any effect.

Set names can be assigned to VCA Masters just like Module Names (see 7.4.1 
Using the module names), further automating the process of setting the channel fad-
ers VCA groupings.

FIG 7-9.  The 
Module Name 
List 

Click to open Module Name List View 

FIG 7-10.  Selected sets.
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To get an overall view of how the Master faders are allocated and when their settings 
change during the show, use the Master Title Database view (see fig 7-11). This view 
shows the text that will be displayed in the alpha-numeric display on each Master 
Fader. 

:1914 5LSSOH0WKURXJK#IHDWXUH

The Master Title Data Base view is one window that features CADAC’s “ripple-
through” effect. This means that when you enter “Real Text” data for a Master Fader 
in one cue, the data will be applied to the same fader in all the following cues up to 
the next item of “Real Text”. The “ripple-through” data is displayed in a different col-
our and if the “Real Text” entry is changed, all the subsequent “ripple-text” items will 
change with it.

This means that you only have to enter Master Fader Titles where they change. SAM 
will take care of the rest for you. The ripple-through items will be recalled to the con-
sole in the same fashion as Real Items.

If you want to stop the Ripple-through at a particular cue, then simply right-click on 
the cell and select Clear - this will blank the cell and set the “Real Text” property. 
Alternatively, Ripple-through may be extended by right-clicking on a cell and select 
Force-ripple from the pop-up menu.

FIG 7-11.  The Master Title Database view and (below) the Master Fader view alphanumerical display.

$OSKDQXPHULF#GLVSOD\
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A Cue contains various data relating to different features of the console. From time to 
time, it may be necessary to edit the contents of one or more cues. The data to be 
edited may be associated with Faders, Modules or Master Title as previously 
described or MIDI and Events (see section 8). 

The current view can be edited directly from the Edit-menu, or through double-click-
ing in the cue view, while those views that are not open can be called up from the 
View menu. If you want to edit a Cue Title, Dynamic action or lists of these, then 
select Edit in the menu bar of SAM’s cue view.

Perhaps you want to edit data in a cue without recalling the cue to the console. The 
easiest way of doing this is through the Edit cursor, displaying Cue data in different 
views in which the desired data can be edited (see 4.3.2 The Edit Cursor).

If you are working with the cursors locked, it will still be possible to look at the cue 
data using the Edit menu function. This function provides a dialogue box with a list of 
all the cues in the show, from which you can select the one to edit. Having made your 
choice, the Active View will show the applicable data from the cue and “separate” it 
from the actual show, thus enabling you to perform the editing. The view is recon-
nected to the current cue as soon as a cue recall function is executed.

NOTE: It is important to remember, that the Edit-menu reflects what View you are in, 
i.e. different views have different menu options.

:1:14 *OREDO#HGLWLQJ

Global editing allows you to change settings for one or more faders/modules in one 
or more cues. The global editing process is three-fold:

■■■■ Selecting the data to be updated
■■■■ Selecting the faders/modules to be set
■■■■ Selecting the cues to which the editing should apply

1. Click on Edit

2. Click on Edit Cue List  

3. Select Cue to edit

FIG 7-12.  The Edit 
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To select Global editing, right-click in the fader frame view and select Global Update. 
A window opens, reflecting the settings of the module and 
cue you have right-clicked on, see fig 7-13. In the left-hand part of the window is a 
picture of the fader/module. Any programmable item in the fader/module may be 
selected for update.

To select, you can either:

■■■■ click items
■■■■ drag a bounding-box around items

The dialog box shows the total number of items selected.

To deselect, shift-click on the item.

FIG 7-13.  The Global Update dialog box.

Programmable items
tomation Manager Revision SAM2005-2
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You may select the faders/modules to be altered either before, or after  you have 
changed the data. To select, simply shift-click or draw a boundary box around the 
faders/modules to be selected. Finally, click on Apply in the Global Update dialog box 
to apply the changes, or click on Update to apply the changes and close the dialog 
box.

NOTE: If you wish to update faders/modules in more than one frame, the check box 
All Frames in the Global Update dialog box must be ticked.

:1:17 6HOHFWLQJ#WKH#FXHV

For safety reasons, the Global Update dialog box opens with the default setting of 
Edit Cue Only. To select more than one cue, click on the option Selected Cues in the 
dialog box and then CTRL-click in the Cue View on each individual cue to which you 
wish to apply the changes. If you want to apply the changes to a range of cues, sim-
ply click on the option Cue Range and then select the start and end cues from the 
drop-down menus in the dialog box.

Select faders/modules

Click Apply

Select cue(s)
Click ApplyFIG 7-15.  Selecting cues.
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In the menu bar, click on View and then click on Cue Notes. A new window will open, 
see below.

This window is called cue notes and can be used for the entry of notes, reminders or 
significant data for any cue of your choice. If you right-click in the window, a menu 
with further options will open.

:1:19 3ULQWLQJ

Printing of the details of the grid-class views can be achieved by using the File->Print 
option. Printer options are set using the standard File->Print Setup menu option. To 
view the result before printing, use the File->Print Pre-view option.

FIG 7-16.  Cue Notes window
tomation Manager Revision SAM2005-2
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;14 0,',#SRUW#PDSSLQJ

CADAC’s Sound Automation Manager (SAM) features 10 MIDI ports, designated A 
to K (the letter ‘I’ is deliberately excluded, so as not to be confused with the cursor). 
These ports are referred to as “virtual” MIDI-ports, since they are not representative 
of any actual hardware. When SAM is first started up, the program searches the 
computer to establish which MIDI-ports are available, for instance, those of computer 
soundcards. The available ports are then listed alongside the CADAC console’s own 
facilities as Physical Devices. The linking between virtual ports and physical devices 
may then be set or changed, by opening the MIDI mapper dialog box.

The dialog box shows that SAM has allocated a default mapping between the first 
four virtual ports and the four available physical devices. Consequently, anything 
being programmed on port A, results in an output from the A socket on the console 
CCM; anything programmed on MIDI port D will result in an output from the MPU401 
interface on the PC (this being the MIDI output socket on a standard PC joystick con-
nector).

;1414 $GYDQFHG#PDSSLQJ#IHDWXUHV

A show can be designed using all of the 10 virtual MIDI ports available. This means 
you can separate the data into logical blocks, each with its own purpose, for instance 
triggering of sound effects, memory recall messages, machine control etc. Hence, 
decisions on how the messages will be sent to the external equipment can be made 
later. The reason for this is that more than one virtual port can be allocated to each 
physical device and SAM will then perform the necessary MIDI merging.

The screen-shot above depicts a scenario where a show originally was designed for 
a CADAC J-Type; and is now being performed using an R-Type, which has only one 
MIDI output port. Alternatively, a scenario where all MIDI messages are being 
directed out of the computer’s MIDI port(s) could be considered:

FIG 8-1.  MIDI mapper dialog box

FIG 8-2.  Allocation of more than 
one virtual port to a physical de-
vice.

FIG 8-3.  All MIDI messages are 
being directed out of the comput-
ers MIDI port(s).
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Show data can be divided into two types; Static data and Dynamic data. Static data 
acts instantaneously while the dynamic data acts over a period. 

A static cue can contain MIDI data, which is therefore referred to as Static MIDI data. 
Figure 8-4 shows a typical MIDI window.

When you recall a cue, the MIDI window will show the current cue with a coloured 
horizontal bar (see fig 8-5 below).

To enter MIDI data, start by assigning a port and a channel number for the MIDI com-
mand. With the cursors in locked mode, select a cue in the cue window (in unlocked 
mode, select cue with the edit cursor); then open the MIDI window by clicking its icon 
in the toolbar.       

FIG 8-4.  The MIDI window.

FIG 8-5.  MIDI window showing data for the MIDI commands.
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A new row is added. Enter a virtual port (A - K) in the column labelled Port, by dou-
ble-clicking on its entry box. After you have entered a port, press Enter on the key-
board. Repeat for channel number.

FIG 8-6.  Opening the MIDI window to enter data.

41#6HOHFW#WKH#FXH 51#&OLFN#WKH#0,',0LFRQ

61#0,',0ZLQGRZ#RSHQV 71#5LJKW0FOLFN#OLQH 81#&OLFN#,QVHUW#1HZ
####WR#RSHQ#D#PHQX

FIG 8-7.  Select port and enter channel number. Press Enter or use the shift+arrow keys to move from cell to cell.

'RXEOH0FOLFN#RQ#HQWU\#ER[ 'RXEOH0FOLFN#RQ#HQWU\#ER[

6HOHFW#SRUW#DQG#SUHVV#(QWHU 7\SH#LQ#FKDQQHO#QXPEHU#DQG#SUHVV#(QWHU
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The port designation represents the virtual port which may be “mapped” to a physical 
device as explained in section 8.1, whereas the channel number is a conceptual 
number contained within the data transmitted. 

To enter data for the MIDI commands, double-click in a suitable ‘cell’ in the grid of 
data. If SAM has started editing - indicated by the cell being displayed with the high-
light background colour - then editing can continue by moving the target around the 
cells, using the shift and arrow keys.

If a NOTE ON or NOTE OFF is entered, SAM will automatically set the velocity to 64 
in accordance with the MIDI specification. This parameter can, of course, be edited 
should this be required. 

FIG 8-8.  Enter values for Note-ON and velocity.

'RXEOH0FOLFN#RQ#HQWU\#ER[/#W\SH#LQ#D
YDOXH#DQG#SUHVV#(QWHU

'RXEOH0FOLFN#RQ#HQWU\#ER[/#W\SH#LQ#D
YDOXH#DQG#SUHVV#(QWHU

FIG 8-9.  Enter value for Note-OFF and velocity.

'RXEOH0FOLFN#RQ#HQWU\#ER[/#W\SH#LQ#D#YDOXH#DQG#SUHVV#(QWHU

#'RXEOH0FOLFN#RQ#HQWU\#ER[/
#W\SH#LQ#D#YDOXH#DQG#SUHVV#(QWHU
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;1614 (QWHULQJ#GDWD#IRU#0,',#SURJUDP#FKDQJH

You can use the MIDI program change function, for instance, to change the memory 
settings on an external sound effects unit. This is done by sending MIDI commands 
from the computer to the equipment you want to control. 

Click on the icon MIDI Program Change to open the associated window, (see fig 8-
10). The first column shows the cue number and the rest of the columns show the 
channels. There can be up to 16 channels on each port, the required port being 
selected by clicking on the Tab at the top of the view. The data for a channel can be 

between 0 – 127 (1 – 128 Japanese format)1 and it refers to a memory number in the 
unit you want to control. For instance, you may have an echo box which has five dif-
ferent types of echoes, numbered program 1 to program 5, stored in its memory. If 
you want echo program number three on channel 1 in cue 1, double-click the box 

Channel A1/Cue 1, type in 3 and press Enter2. 

Continue to enter data into any of the other boxes in the same way; just double-click 
the box and type in a number. Remember to press Enter to end editing or a shift+ 
arrow key to move to another cell. Note that the MIDI program change window fea-
tures a “ripple-through” effect (see 7.6.1 Ripple-through feature), meaning that all 
subsequent boxes in the same column in which you enter your data, will get the 
same data. If you, for instance, enter 123 for Cue 5.00/channel A3, all cues subse-
quent to this cue will get this value. This data (the ripple-through data) will be shown 
in red as opposed to the first box, in which the text will be green.

The text entered is referred to as “real data” and the automatic entries are referred to 
as “ripple through data”. If you subsequently edit the “real data”, then the “ripple 
through data” will change with it.

1. See section 8.3.2 USA or Japan format
2. Note that you may need to check the instruction manual for the MIDI-device to ensure that 

the program number is the same as the Program Change number.

'RXEOH0FOLFN#GDWD#ER[/#HQWHU

FIG 8-10.  Enter Program change data.

6HOHFW#D#FXH

&OLFN#RQ#WKH#LFRQ
3URJUDP#&KDQJH

GDWD#DQG#SUHVV#(QWHU
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The MIDI-program changes are issued using numbers 0 – 127. Unfortunate circum-
stances have created a situation where the Japanese standard uses the numbers 1 
– 128. The data values transmitted are still 0 – 127, but they are typed in and dis-
played as 1 – 128. This means, when you send a command from equipment using 
US standard to equipment using Japanese standard, the digit 0 will be displayed as 
1. The SAM naming facility for MIDI channels therefore includes a format setting 
option to cater for this, see section 8.4 MIDI names.

;17 0,',#QDPHV

To help you remember which equipment is being controlled by which MIDI-channel, 
you can assign a name to each channel. Right-click over the column headers at the 
top of the MIDI-window to open a menu with the option Set names. Click this option 
to open a dialog box in which you can enter and edit channel names. On the right 
hand side of the name column is a check box which you can check/uncheck depend-
ing on whether you communicate with Japanese standard based equipment (see 
8.3.2 USA or Japan format).

FIG 8-11.  Assigning names to MIDI-channels.

5LJKW0FOLFN#RQ#FROXPQ &OLFN#QDPHV#DQG#IPW

(QWHU2HGLW
FKDQQHO#QDPH

&OLFN#2.

&KHFN#ER[#IRU
-DSDQHVH#IRUPDW
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By using the MIDI Machine Control, you can have sound effects stored on a machine 
using magnetic tape or other media and have them played back when required. 

In order for the tape machine to be able to locate the sound effect, you have to spec-
ify where to look on the tape. You do this by telling the tape machine how long it has 
to play to reach that part of the tape that carries the sound effect. The playing time is 
measured in hours, minutes, seconds, frames and sub-frames. A frame is equal to 1/

25 of a second3 and a sub-frame is 1/100 of a frame.

To locate a sound effect on the tape, you use the command Locate. Other com-
mands available are:

■■■■ Play
■■■■ Stop
■■■■ Rewind
■■■■ Fast Forward

In the case where you use more than one tape machine, you have to give each of 
them a specific ID. The default value is 0 and the ID you assign to the machine is 
usually dependent on whether the machine has been pre-programmed by the manu-
facturer for a certain value or can be programmed by the user.

Before you enter data for MIDI Machine Control, you have to specify the frame rate4, 
(see fig 8-13 below). To enter data for MIDI Machine Control, double-click on the 
entry boxes required.

3. Or 1/24th or 1/30th depending on the FPS standard.

FIG 8-12.  The MIDI machine control window.

4. This is only necessary if your machine is sensitive to frame numbers outside of the range for 
its set standard. Most machines will sensibly locate to the nearest “legal” frame.

FIG 8-13.  Enter data for MIDI machine control.

'RXEOH0FOLFN#SRUW# 6SHFLI\#WLPH
6HOHFW#IUDPH#UDWH

6HOHFW#FRPPDQG (QWHU#,'

127( =#)RU#VD IHW\ #UHDVRQV /
LP SOHP HQ WD WLR Q #R I#00& # LV
GH OLE H UDWH O\ #OLP LWHG #WR #WK HVH
FRPPDQGV 1#3 OHDVH #GR #QR W
KHV LWD WH #WR #FRQWD FW #&$'$& /
VKRXOG #\RX #KDYH #DQ\ #TXHULH V
DERX W#WK LV 1
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The Sound Automation Manager has the capability of transmitting system exclusive 
strings. To use this feature, just type in a string of of space separated hexadecimal 
values and they will be sent out from the selected port. 

Although this feature is called the SysEx view, you can enter any values, such as 
notes, controllers, etc., however it’s more reasonable to do this through the MIDI 
Data view. In the example above, a SysEx message will go out from port C, contain-
ing an MIDI Machine Control message (MMC). The program (SAM) does not check 
for validity, so it is up to you to make sure the string is a valid MIDI-message.

When SAM transmits a MIDI-string, either from the sequence control, the MIDI 
Machine Control view or the SysEx view, it uses a certain aspect of the Windows® 
MIDI system which, unfortunately adds a bunch of extra data to the end of what SAM 
sends. This may cause some degree of grief in that controller 64 (sustain) will be set 
back to off for every channel, and also a Note Off is sent for any Note Ons that have 
been sent. In most cases this data will be harmless, but if you’re trying to turn a note 
on and leave the note off for another sequence or use controller 64, this feature of 
Windows will annoy you, to say the least. For the time being, we suggest using the 
static MIDI data window or send the sequences via the CCM.

;1: '\QDPLF#0,',#GDWD

Dynamic MIDI such as a MIDI-sequence is the function of playing files containing 
MIDI data in real time. Replay of a MIDI sequence is triggered by a Cue Recall. A 
MIDI sequence file (or files) can be attached to a Cue using the MIDI Sequence List 
View. This View looks very much like the Cue List, but does, in addition, display all 
the information pertaining to the MIDI sequences being used in the show. 

Double-clicking over the Cue Name column will open the Cue Name dialog box so 
that the Cue Name can be edited, but further cue editing must be done using the 
Cue View.

FIG 8-14.  The MIDI SysEx window

Double-click in the columns to enter your data
tomation Manager Revision SAM2005-2
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In the MIDI toolbar, click on the icon Seq List to open a new window.

This window is in all essence identical to the other grid-class views. You may, for 
example right-click on any header in the window which will then cause a menu to be 
displayed. The options in this menu are rather self-explanatory, it may however be 
worthwhile giving some attention to the menu option called Properties. When you 
left-click on this option, a dialog box will open called View Properties. This dialog box 
has 9 tabs, each enabling you to set a number of parameters such as background 
colour, text colour, grid lines in addition to data for the items in the MIDI sequence 
list. For more information on View Properties, see 5.4 View Properties.

If you double-click on any of the columns or rows (except for the cue name column) 
in the MIDI Sequence List window a new dialog box opens, see below. 

The name of the attachment, playback time and status (enabled/disabled) will then 
be indicated in the corresponding columns in the MIDI sequence list.

FIG 8-15.  MIDI Sequence List

&OLFN#VHTXHQFH#OLVW

7KH#0,',#6HTXHQFH#/LVW#ZLQGRZ#RSHQV

FIG 8-16.  MIDI Sequence Attachment 
dialog box

'RXEOH0FOLFN#WR
RSHQ#GLDORJ#ER[
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The drop-down list in the upper part of the dialog box provides options for which MIDI 
port the sequence will be played through, whereas the menu in the middle part of the 
dialog box lists available MIDI sequences in the current show directory. If you want to 
attach a MIDI sequence from another show or directory, click the Browse button 
where upon a standard file selection dialog box will be displayed; you can then 
search for and attach the required sequence.

NOTE: Beware of sequences stored on removable drives, since SAM records the 
Path List as part of the show data (see fig 8-18). If you do attach a file stored on a 
removable drive and then try to run the show without the removable drive present, 
this will cause problems, since SAM will try to load the sequence and run it.

;1:16 0HUJLQJ#RI#0,',#VHTXHQFHV

Multiple sequences can be attached to a single cue; they will then begin playing 
simultaneously. However, individual sequences may be stopped, using the little Stop 
button above the sequence icons which appear in the MIDI sequence List View.

Where several sequences are targeted at one single MIDI port; they will be merged. 
These sequences may have been attached to the same cue (reconstructing a multi-
track MIDI file) and hence been started simultaneously, alternatively attached to dif-
ferent cues and started at different times. In either case, SAM will handle the merg-
ing in the background.

PLEASE NOTE: Merging of MIDI sequences is not available through MIDI ports on 
earlier CCMs. Only the CADAC R-Type CCM is capable of handling multiple 
sequences (maximum of four). The best way to get around this is to use the PC MIDI 
ports where extensive usage of this feature is required.

FIG 8-17.  Merging of MIDI sequences
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MIDI-files are normally stored in the same folder as the one containing the show. 
When you want to record a MIDI-sequence, click on the MIDI Ctrl option in the SAM 
toolbar. This will cause the MIDI sequence control window to open.

To record a MIDI-sequence, type in the desired filename or use the Browse button, 
should you wish to overwrite an existing file. Then press Rec in the MIDI Sequence 
control window. You may at this point playback a MIDI-sequence into the console or 
PC port selected, where it will be time-stamped and recorded. Note that time will 
start at zero when the first MIDI event is received.

When you have finished recording the MIDI sequence, click Stop and the sequence 
will be saved in the specified file. 

To play back your recording, first open the file that contains the sequence (click on 
Browse in the Playback section to find the folder) then click on Play in the control win-
dow.

&OLFN#RQ#6HT#&WUO

7KH#0,',#VHTXHQFH#FRQWURO#ZLQGRZ#RSHQV
FIG 8-18.  The MIDI sequence control window
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Most software sequencers can save or export a “standard MIDI-file”. SAM cannot 
use these files directly but has the ability to convert them to its own native MSF-for-
mat. If you would like to attach a standard MIDI-file with the file extension *.mid to 
any cue, proceed as follows:

Having followed the procedure described above, you will be presented with another 
dialog-box that requests you to confirm the conversion (see below):

41#'RXEOH#FOLFN#RQ#WKH#DWWDFKPHQW#ILHOG
IRU#WKH#UHTXLUHG#FXH#QXPEHU

51#7KH#0,',#VHTXHQFH#
$WWDFKPHQW#'LDORJ#RSHQV

61#&OLFN#RQ#%URZVH#DQG
VHOHFW###WKH#IROGHU#WKDW
FRQWDLQV#WKH#ILOH#\RX#
ZDQW##WR#FRQYHUW 71#&OLFN#RQ#WKH#ILOH#\RX#ZDQW

WR#FRQYHUW

91#&OLFN#<HV

FIG 8-19.  Converting to MSF-format

81#&OLFN#2SHQ

&OLFN#RQ#&RQYHUW $#QHZ#ZLQGRZ#RSHQV#VKRZLQJ#DOO#WKH#
H[WUDFWHG#ILOHV#LQ#WKH#FRQYHUWHG#ILOHFIG 8-20.  Confirming conversion
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MIDI-files will generally contain a number of “tracks”, each containing a musical 
sequence. These tracks are normally played back simultaneously, however, in the-
atre sound effects, each track is more likely to contain a separate sound effect 
sequence. SAM will convert each track into a separate MSF-file which then will be 
displayed as shown in the bottom right window in fig. 8-19. Clicking on the plus-sign 
to the left of the file name will expand each branch of the tree thereby providing 
details of each MSF file generated. 

Following file conversion, any one of the MSF-files can be attached to the relevant 
cue.Clicking once on one particular MSF file will highlight that file and the OK button 
will be enabled. Clicking OK then closes the window and inserts the name of the 
selected file into the Attachment text box in the MIDI sequence list. Note that, even if 
you cancel the attachment to a cue, the MSF-files will have been created and kept on 
your disk storage.

If all tracks in a MIDI file are to be combined to one MSF file, then save the MID file 
from your sequencer as a “Type Ø” MIDI file - see the MIDI specification for details 
regarding Type Ø and Type 1 files.

;1; (YHQWV

The console CCM contains 8 relays that can be user designated. An event can be 
defined as the state of a relay. The state can be Off, On or Pulse. The relays can be 
programmed to change state when a cue is recalled.

Events are used to control external equipment such as CDs, sample players, effect 
units etc. At present, most CADAC consoles are equipped with 8 event relays.

Click the Events icon in the toolbar to open the Events window.

In the Event window, the current cue is the cue you have highlighted with the edit cur-
sor.

To change data in the event window, you left-click on the event in the column you 
want to change. Each click with the mouse increments the data to its next choice (the 
order being Off-On-Pulse-Off).

If you are not using a mouse, press ctrl + 1 to go through the selections for 
event 1, ctrl + 2 for event 2 etc.

Click on properties on the popup menu to arrange column headers vertically or hori-
zontally.  This menu also contains options for moving the column right/left or Hide. 
For information on the Properties option, see 8.7.1, on the next page.

FIG 8-21.  The Events window.

&OLFN#WKH#HYHQWV#LFRQ

/HIW0FOLFN#WKH#HYHQW
#############WR#VKRZ#D#PHQXWR#FKDQJH#WKH#GDWD

5LJKW0FOLFN#WKH#KHDGHU&OLFN#RSWLRQ
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You can give each event a name by right-clicking over the events window to display a 
menu. Select Properties in the menu to open a dialog box allowing you to enter and 
edit the names. When the show is saved, these names will automatically be saved 
with it and then appear as ToolTips in the main window.

FIG 8-22.  Edit event names.

&OLFN#3URSHUWLHV /HIW0FOLFN#WKH#KHDGHU
WR#RSHQ#D#PHQXWR#RSHQ#D#GLDORJ#ER[

&OLFN#FROXPQ#WR#FKDQJH#QDPH
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When a show is being performed, the sound engineer may require a quick and relia-
ble indication of events and data transfer (External actions) that will take place next. 
This applies particularly to commands issued by the Automation System to 
external equipment through MIDI or relay closures. A visual representation of these 
External Actions can be made available in the Cue View by enabling the X-Act 
(External Action Indicators) column. Select X-Act Indicators from the Options menu 
to open the control dialog box in fig 8-23.

In the dialog box, the individual items to be indicated in the Cue View may be 
selected by clicking the associated check boxes. The overall X-Act column can also 
be turned ON/OFF from this dialog box.

The X-Act Indicators, reflecting the choices that have been made in the dialog box, 
appear in a new column at the right-hand side of the Cue View window. They are dis-
played as small blocks, each with its own designated colour.

If you want to check exactly what action is to be taking place, then just hover over the 
desired indicator. This will cause a ToolTip, describing the action, to appear.

FIG 8-23.  External Action Indicator Setup

Select item to be 
indicated

Enable feature

FIG 8-24.  The X-Act Indicator column

The X-Act Indicator column
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A cue can define a set of fixed fader positions. A cue, however, may contain a 
dynamic mix, which by definition is a set of fader movements performed while the 

cue containing that mix is active1. Other names for a dynamic mix are dynamic files, 
dynamic mix files or just mixes. Technically, a mix is a file stored on the computer 
hard disk containing information on how the motorised faders will move or change 
with time.

<1414 5HFRUGLQJ#D#0L[

When you recall a cue, the Record Enable button in the tool bar becomes active. 
Click this button to open the Dynamic Record Time window and to activate the Start 
Record button. When the window opens, the time display is green and no counting 
takes place. When you press Record Start, the display changes to red indicating 
recording can begin. If the fader is in ready mode any of the following: fader move-
ment, mute set/clear or group change will initiate recording and the time Dynamic 
Record Time window will commence counting. 

SAM now records any movement of Record Enabled faders/activated mute buttons/
group assignments until the Stop Record button is pressed. The resulting mix-file will 
be attached to the current cue and a time value will be displayed in the time column 
of the cue window. An icon indicating that the cue has a dynamic mix attached to it 
will be displayed in the info column.

1. Note that a dynamic file/mix cannot be defined unless the show has been given a name.

FIG 9-1.  Recording a dynamic mix.

&OLFN#UHFRUG#HQDEOH '\QDPLF#5HFRUG#7LPH#ZLQGRZ#RSHQV

6WDUW#5HFRUG##EXWWRQ#EHFRPHV#DFWLYH
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If a cue has a Mix-file attached to it, which is indicated by the icon in the info column 
of the cue window, you can replay the mix when the cue is recalled. The cue can be 
recalled either from the CCM in the console or by clicking the icon in the toolbar. It is 
possible to have SAM auto-start the mix as the cue is recalled. For this to happen, 
tick the box in the Dynamic Edit Dialog Box (see fig 9-3).

When you replay a mix, the data on the hard disk is sent back to the faders/mute 
functions/group assignments in correct order and at the correct time. The faders/
mute functions/group assignments will then reproduce the actions originally per-
formed by the operator.

A coloured horizontal bar along the name field in the cue window indicates the 
progress of the mix. Some of the buttons in the tool bar will also become active to 
allow the commands Pause/Continue/Stop to be issued.

<1416 (GLWLQJ#D#0L[

You can edit an existing Mix by: 

■■■■ Recalling the cue
■■■■ Setting Record Enabled via the icon in the toolbar
■■■■ Then starting playing the mix. 

Any movement of Record Enabled faders/set mute/group assignment functions will 
be translated into data and merged into the existing mix-file. The result will be stored 
as a new file attached to the same cue. The previous mix-file will be moved one step 
down the mix tree (see fig 9-3) from where it may be retrieved later if required.

FIG 9-2.  Replaying a dynamic mix.
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When you record a mix, the data is attached to a cue and the previous mix (if any) is 
moved to a list specific for that cue. Over time, the list builds up a history of mixes for 
that cue, called the Mix tree. By double-clicking the left mouse button over the Time 
or Info columns of the cue window, you can open a dialog box in which you can access 
the control functions associated with the mixes (see fig 9-3 below). 

The filename of the current mix is shown in the long text box. To view the history of 
mixes for the cue, click the down arrow on the right hand side of the text box. High-
light any entry in the list and click on it to retrieve it, thereby making it the current mix.

To edit “user comment”, click on the Edit Mix File button. Use this feature to give 
each mix a title describing what it does.

The Edit Dynamic window can also be accessed by clicking on Edit in the File bar 
and then select Edit Dynamic, provided that the cue is selected with the Edit Cursor 
in the cue window. If it is not, click on Edit Dynamic List in the Edit menu and then 
select the cue.

FIG 9-3.  Control functions associated with the mixes.
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While a dynamic mix is being replayed, it is possible to recall a static cue. You can 
either choose to go on to the next sequential cue, see fig 9-4, or perform a non-
sequential jump to the cue of your choice.

To recall the next static cue while a dynamic mix is being played as part of the current 
cue, you simply press PageDn, which will recall the next cue in the cue list. If you 
want to recall a cue from somewhere else in the list, press shift + F3 and enter the 
number of the cue required in the dialog box displayed.

<17 5HSOD\LQJ#WZR#RYHUODSSLQJ#PL[HV

If you have two consecutive cues with dynamic mixes attached to them and you want 
them to overlap each other, simply press PageDn to go to the next cue. The first 
dynamic will continue to play and second dynamic will begin playing immediately, 
provided the Auto-start feature is enabled or when you click on the play button in the 

toolbar. Pressing F11 will have the same effect2.

If the next dynamic is held in a cue, not immediately following the one holding 
dynamic A, press Shift + F3 to specify the required cue number.

The bars in the Cue name column indicate the progress of the dynamics.

FIG 9-4.  Recalling a static cue while a dynamic mix is being played.

'\QDPLF#PL[#EHLQJ#SOD\HG 6WDWLF#FXH#UHFDOOHG#ZKLOH
G\QDPLF#PL[#LV#SOD\HG

2. In the instance where a second dynamic is enabled, it is considered to be Dynamic B. Func-
tion keys F10 and F11 provides a second set of Start/Stop and Pause/Continue buttons.

FIG 9-5.  Replaying 
two overlapping mixes. '\QDPLF#PL[#$ '\QDPLF#PL[#%
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In the Dynamic Edit window shown below, there is a check box for enabling the step 
time feature. Tick this box and enter a time value in the box on the right labelled Step 
time to next cue. This value determines when the current cue will change to the next 
sequential cue.

You can also have the program perform a non-sequential cue jump, which is to say it 
allows you to jump from one cue to any other cue of your choice. To do this, first you 
enable the non-sequential cue jump feature (see fig 9-6 above). Then, in the box to 
the right, you enter the number of the cue to which you want the non-sequential jump 
to take place.

FIG 9-6.  The step functions.
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A dynamic mix may sometimes be as simple as to move faders from one position to 
another in a given amount of time. Rather than to go through the trouble of creating a 
mix file, you can use the Cross-Fade feature to make this operation easier. You will 
find the cross-fade control in the Dynamic Editing dialog box.

If you want to use the cross fade feature, tick the enable box and enter a time value in 
each of the boxes provided. Note that you may wish to have a different time for faders 
moving up and for faders moving down.

An icon will be displayed in the Info column of the Cue window to indicate the pres-
ence of the cross fade. When the cue is recalled, a time bar will be displayed in the 
cue name field to indicate its progress.

Cross-fades normally works so that one cue in the show holds the starting position 
and the following cue (programmed as described above) holds the ending position. If 
you, however, move the faders in the console between recalling these cues, the 
cross-fade will be calculated in real time, based on the actual position of the faders.

127(=#7KH#&URVV0IDGH#IHDWXUH#LV#DSSOLHG#WR#$//#RI#WKH#IDGHUV/#LQ#DOO#
IUDPHV#LQ#WKH#FRQVROH1

FIG 9-7.  The Cross-fade function.
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Symbols

*.BAK 6-9
*.Cue 6-9
*.MIX 6-9

A

Add User 5-2
Adding a new cue 4-7
alphanumeric title 7-3

B

back-up copies of the show 5-6
Backup Show 6-3
Bad Link 6-5

C

CGC shows 6-1
Child Windows 3-2
Click drag 3-3
Communicating with the console 1-2
Computer requirements 1-1
Configuring the frame 2-3
Context sensitive menus 3-4
control external equipment 8-13
Converting a MIDI sequence 8-12
Copy 4-13
Creating a new show 4-4
Creating Links 6-7
Ctrl click 3-3
Cue Cursors 4-2
cue name 4-1
cue number 4-1
Cue Window 4-1
cue with a # in the cue number column 4-7
Current Cue cursor 4-2, 4-3
Cursor response to console commands 4-4
Cut 4-13
Cut, Copy and Paste 4-13

D

Deleting cues 4-11
Directories 5-6
Double click 3-3
Drag the fader knob 7-3
Dynamic Cues 9-1
Dynamic Record Time window 9-1

E

Edit Cue Cursor 4-2
Edit Cursor 4-3
edit the cue title 4-11
Edit Title List 4-11
Editing a Mix 9-2
Editing the cue name 4-11
Entering a channel name as a DC Master Title 7-6
Ethernet hardware 1-2
5-2       Sound Automation Manager



INDEX-2

Sound Au
Event names 8-14
Events 8-13
Exporting a console configuration 2-6
External actions 8-15

F

Fader detail window 7-3
Fader frame(s) 7-2
Frame configuration 2-3
Function keys 3-3

G

Get Maps 2-10
Grid Class Views 5-5

H

history of mixes for a cue 9-3

I

Importing a console configuration 2-5
Insert 4-7
insert a new cue 4-7
Installing from CD-ROM 1-1
Installing from Floppy Disc 1-2

L

Last User Settings 5-1
Left click 3-3
Load Links 6-8
Locate 8-7
Lock Views 3-2
locked cursors 4-4
Locking and unlocking the cursors 4-2

M

Map file 2-5
Mapping 6-4

conflict 6-4
Load from console 6-4
Load from show 6-5

Maste Title Database View 7-8
Master faders 7-8
Menu Bar 3-2
MIDI

Advanced mapping features 8-1
Converting a standard MIDI sequence 8-12
Dynamic MIDI data 8-8
Features 8-1
Machine Control 8-7
Merging of MIDI sequences 8-10
MIDI data 8-2
names 8-6
port mapping 8-1
Program Change 8-5
ripple-through 8-5
Sequence attachment dialog box 8-10
sequence control 8-11
Sequence List 8-9
SysEx View 8-8
USA or Japan format 8-6
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MIDI data 8-2
MIDI Machine Control 8-7
MIDI names 8-6
MIDI Program Change 8-5
MIDI sequence control 8-11
MIDI Sequence List 8-9
MIDI-message valid 8-8
Mix tree 9-3
Module Frame Windows 7-4
Module Names 7-5
module names list 7-5
Mouse Pointer Shape 3-4
Moving cues in the Cue window 4-9
Moving cues using Cut and Paste 4-10

N

Naming the console modules 7-5
New Blank 6-5
New User 5-2
non-sequential cue jump 9-5
Number of frames 2-2

O

Open a new show 6-1
Open last show 6-1
Opening a CGC-show 6-9
operational settings 5-6
Options menu 5-1
overlapping mixes 9-4

P

PageDn key 7-2
Parent Window 3-2
Paste 4-13
picture of the console faders 7-2
programmable 7-4
programmable potentiometer 7-4
Put Maps 2-10

R

Readme file 1-3
Real-time updating 7-4
Recalling a cue 4-6
Recalling static cues while a mix is playing 9-4
Record Enable 9-1
Record Enabled faders 9-2
Record Start 9-1
Recording a Mix 9-1
Redo 4-12
relays 8-13
Reload last show 5-1
Reload Windows Placement 5-1
Re-mapper 6-5
Re-Mapping a correctly configured console 6-8
Renumbering cues 4-8
Replaying a Mix 9-2
Restore Show 6-3
Right click 3-3
Ripple-through 7-8
ripple-through effect of VCA assignment in faders 7-6
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Sam Configuration 2-1
Sam Setup 2-9
Sam.Cfg 6-9
SamSetup 2-1
Save 6-2
save a console configuration 2-6
Save As 6-2
Save Links 6-8
Saving a frame configuration 2-4
Saving a show 6-2
Saving data to a cue 4-6
saving the link-set as a file 6-8
Séance 1-2
Séance network port 2-8
Select the desired console 2-1
Select user 5-2
Selecting cues 4-5
Sequence 8-9
Shift click 3-3
Show All Links 6-6
standard MIDI-file 8-12
start-up options 5-1
Static MIDI 8-2
step time 9-5

T

TCP/IP software 1-2
the order or sequence of the cues 4-5
Title Bar 3-2
title colour 4-11
Tool Bar(s) 3-3

U

Undo 4-12
undo an Import or GetMaps 2-7
Undo List 4-12
Update Séance 2-9
update the Seance program 2-9
USA or Japan format 8-6
User Properties 5-3
User Setup files 5-6
Using the module names 7-6

V

View Properties 5-4

W

What constitutes a show 6-9

X

X-Act Indicators 8-15
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